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SUMMARY

Adjacent membrane receptors can show different cellular responses to ligand
stimulation. Here, we describe a super-resolution microscopy imaging protocol
for tracking the dynamics of two different membrane-bound receptors in single
cells. We describe the transfection protocol by electroporation. We detail the im-
aging procedure for receptors in a single cell. We then outline the data analysis
pipeline. We have applied this protocol to imaging of endocytosis of the LOX-1
and AT1 in CHO-K1 cells, but the protocol can be applied to a variety of mem-
brane receptors in other cell lines.
For complete details on the use and execution of this protocol, please refer to
Takahashi et al. (2021).

BEFORE YOU BEGIN

Many GPCRs form homo- and heteromers at the cell surface. Thus, GPCR signaling is not only deter-

mined by conformational changes induced by agonist binding, but is also allosterically regulated by

interactions with other receptors (Audet and Bouvier, 2012). Receptor interactions are not limited to

GPCRs. We have found that a pattern recognition receptor (PRR), lectin-like oxidized low-density li-

poprotein (oxLDL) receptor (LOX-1) and a GPCR, angiotensin II type 1 receptor (AT1) form a complex

(Yamamoto et al., 2015) and that the cellular uptake of oxLDL wasmediated by b-arrestin-dependent

endocytosis of AT1 (Takahashi et al., 2021). The interaction of the receptors was supported by ex-

periments including immunoprecipitation, in situ PLA assay (Yamamoto et al., 2015) and live-cell im-

aging of the two receptors (Takahashi et al., 2021). Here, we provide a protocol of the latest exper-

iment that will allow for live-cell imaging of endocytosis of the two adjacent membrane receptors,

LOX-1 and AT1 in a single cell (Takahashi et al., 2021). Complex formation is observed by the merge

of labeled receptors, and endocytosis is observed by the instantaneous disappearance of receptors.

This phenomenon was quantitatively analyzed by the alteration of number of the puncta which is a

cluster of fluorescence-tagged receptor using images before and after stimulation with ligand. We

showed that oxLDL, compared with vehicle, reduced number of red puncta representing LOX-1

upon stimulation. The phenomenon was not observed in cells transfected with AT1 which has muta-

tions in the arrestin-binding sequence (Takahashi et al., 2021). The protocol described heremodified

the original technique that required manual counting of the puncta (Takahashi et al., 2021) by utiliz-

ing the ImageJ software, which enable the puncta to be counted automatically. The essential mate-

rials of this protocol are, SpinSR10 inverted spinning disk-type confocal super-resolution micro-

scope (Olympus, Japan), ImageJ and its plugin, Red and Green Puncta Colocalization Macro.

SpinSR10 allows for 120 nm resolution and image acquisition speeds as fast as 0.005 s per frame,

as well as reduced phototoxicity, which is useful for live observation of separate receptors labeled
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in two different colors. This macro was originally designed to analyze the co-localization of GFP-LC3

and RFP-LC3 puncta in cells transfected with the RFP-GFP-LC3 tandem reporter construct to assess

intracellular autophagic fluxes (Pampliega et al., 2013).

KEY RESOURCES TABLE

MATERIALS AND EQUIPMENT

REAGENT or RESOURCE SOURCE IDENTIFIER

Critical commercial assays

Poly-L-Lysine ScienCell, USA Cat#0413

Resuspension buffer (buffer R) Invitrogen MPK1096

Electrolytic buffer (buffer E) Invitrogen MPK1096

Electroporation device Digital Bio Technology MP-100 Microporator

Neon pipette Invitrogen MPK1096

Neon 10 mL tips Invitrogen MPK1096

Neon tube Invitrogen MPK1096

Experimental models: Cell lines

CHO-K1 ATCC ATCC CCL-61

Recombinant DNA

pmScarlet_C1 Addgene Cat#85042

pcDNA3-EGFP Addgene Cat#85042

Other

Super-resolution microscope Olympus, Japan SpinSR10

Lens Olympus, Japan 1003 NA-1.49

Camera Hamamatsu Photonics KK, Japan ORCA-Flash 4.0 V2

CellSens Dimension 1.11 Olympus, Japan SpinSR10

3D deconvolution algorithm Olympus, Japan SpinSR10

Microscope incubation system TokaiHit, Japan STX Series Stage Top Incubator System

ImageJ1.53K Java 1.8 (Schneider et al., 2012) https://imagej.nih.gov/ij/

Red and Green Puncta Colocalization Macro (Pampliega et al., 2013) https://imagejdocu.tudor.lu/
plugin/analysis/colocalization_analysis_macro_
for_red_and_green_puncta/start

Chemicals, peptides, and recombinant proteins

Trypsin Lonza, USA Cat#CC-5012

Trypsin neutralized solution (TNS) Lonza, USA Cat#CC-5002

HEPES Buffered Saline Solution (HBSS) Lonza, USA Cat#CC-5022

D-PBS FUJIFILM Wako, Japan Lot NO.04529795

10 cm cell cultured dish Corning Cat#353801

35 mm glass coverslip bottom cell cultured dish Iwaki, Japan Cat#0161951

Cell culture medium (Ham’s F-12 Nutrient Mix) Gibco Cat#2193045

Fetal Bovine Serum (FBS) Gibco Cat# A31605

Antibiotics Penicillin-Streptomycin Gibco Cat#2185242

Imaging buffer

Reagent Final concentration Amount

NaCl 125 mM 3.65 g

KCl 5 mM 186.38 mg

MgCl2 1.2 mM 57.13 mg

CaCl2 1.3 mM 72.15 mg

HEPES 25 mM 3 g

D-glucose 3 mM 270.24 mg

NaOH (5 N) Adjust PH 7.4 n/a

ddH2O n/a Fill to 500 mL

Total n/a 500 mL

Store at 4�C. The maximum time for storage is 6 months.
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STEP-BY-STEP METHOD DETAILS

Construction of plasmid vectors for the receptors of interest

Timing: 5–7 days

The receptors of interest are tagged with fluorophores in different colors for easy visualization. In this

protocol, we used Human LOX-1 (GeneBank NM002543) and Human AT1R (GenBank NM_000685)

as receptors of interest. LOX-1 tagged with V5-63His at the C-terminus (V5-LOX-1) was subcloned

into the EcoRI/EcoRV site of pmScarlet_C1 (Plasmid #85042, Addgene) (mScarlet-LOX-1), fluoro-

phores located at N terminal. HA-FLAG-hAT1 was subcloned into the EcoRI/SalI site of pcDNA3-

EGFP (Plasmid #85042, Addgene) (hAT1-EGFP), fluorophores located at C terminal. In this experi-

ment, fluorophores were inserted into the intracellular regions of LOX-1 and AT1.

Note: Whether to place the fluorophore at the C- or N-terminal end of the receptor to be

labeled must be based on an understanding of the characteristics of the receptor and its intra-

cellular or extracellular localization.

Preparation of the samples for the imaging experiment

Timing: 2–5 days

This step includes cell culture, preparation and transfection by electroporation.

1. Defrost cells.

Firstly, defrost one CHO-K1 stock from liquid nitrogen under 37�C water bath 3 min, then equally

split cells liquid into two 10 cm dishes containing 10 mL Cell culture medium (medium+10%

FBS+1%antibiotic) and culture in a 5% CO2 incubator at 37�C 12 h. If cultured cells are obtainable,

you can skip this step.

2. Cell passage.

a. Each 35 mm glass coverslip bottom dish is pre-coated with 200 mL 10 mg/mL Poly-L-Lysine

(1:1000) diluted in ultrapure distilled water at a 37�C incubator for an hour.

b. Wash each 35 mm glass base dish with 200 mL 37�C PBS three times.

c. Bring the cells in two 10 cm dishes from incubator, wash each 10 cm dish with 2 mL 37�C HBSS

once, then add 2 mL 37�CTrypsin to detach cells in a 5% CO2 incubator at 37�C for 2 min.

d. Add 2mL 37�CTNS to neutralize Trypsin, then transfer themixture from each dish to one 50mL

tube, and centrifuge at 210 3 g for 5 min at 25�C.
e. Aspirate supernatant, add 10 mL 37�C Cell culture medium (medium+10%FBS) to suspend

cells, count cell number, transfer 5 3 104 cells to each 1.5 mL tube, and centrifuge at

210 3 g for 5 min at 25�C.
3. Electroporation.

a. Place Neon tube, pipette and tips, buffer R, buffer E and other required experimental tools in a

biological safety cabinet (Figure 1A).

b. Suspend cells (5 3 104 cells) with 10 mL buffer R per 1.5 mL tube.

c. Add 400 mL Cell culture medium (medium+10%FBS) to another pre-prepared 1.5 mL tube

(Figure 1B).

d. Turn on the Neon device and enter the electroporation parameters. Our parameters in this

experiment were, Pulse voltage 1,560 V, Pulse 5 ms, Pulse number 10, Cell density 5 3 106

cells/mL Transfection efficiency 90%, and tip type 10 mL.

e. Fill the Neon tube with 3 mL buffer E (Figure 1C).

f. Insert the Neon tube into the Neon Pipette Station until it ‘‘clicks’’ into place (Figure 1D).
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g. Add 1.5 mg/35 mm glass coverslip bottom dish AT1-EGFP and 0.5 mg/35 mm glass coverslip

bottom dish mScarlet-LOX-1 to the 1.5 mL tube from step b containing cells and mix gently.

h. Insert a 10 mL Neon tip into the Neon pipette, then press the push-button on the Neon pipette

to the first stop and immerse the Neon tip into the cell-DNA mixture. Slowly release the push-

button on the pipette to aspirate the cell-DNA mixture into the Neon tip (Figure 1E).

i. Insert the Neon pipette with the sample vertically into the Neon tube placed in the Neon

Pipette Station until it ‘‘clicks’’ into place, then press Start button on the Neon device

touchscreen (Figure 1F).

j. Neon device touchscreen displays ‘‘Complete’’ to indicate that electroporation is complete

(Figure 1G). Electroporation parameters of CHO-K1 cell line from Neon Transfection System

Cell Line Data is shown in Figure 1H.

k. Remove the Neon pipette from the Neon Pipette Station and immediately transfer the sample

mixture from the Neon tip into the prepared 1.5 mL tube from step c containing 400 mL Cell

culture medium (medium+10%FBS).

l. Transfer 200 mL cell suspension from above 1.5 mL tube into each pre-coated 35 mm glass

coverslip bottom dish, incubate in a 5% CO2 incubator at 37�C for 12 h (Figure 1I).

Figure 1. Pictures in the order shown in the electroporation protocol and SpinSR10 accessory equipment

(A–L) Electroporation was performed on CHO cell lines with the Neon� Transfection System (A–G and I). Required

experimental buffers and tools in the biological safety cabinet (A). Transfer 400 mL culture medium into pre-prepared

1.5 mL tube (B). Transfer 3 mL buffer E into Neon tube (C). Insert the Neon tube into Neon Pipette Station (D). Aspirate

the cell-DNA mixture into 10 mL Neon tip (E). Place the Neon pipette into Neon Pipette Station (F). Neon device

touchscreen displays ‘‘Complete’’ (G). Place 200 mL cell suspension into 35 mm glass coverslip bottom dish (I).

Electroporation parameters of CHO-K1 cell line from Neon Transfection System Cell Line Data (H). Established

connection between the microscope and the PC software CellSens Dimension 1.11 (J). Microscope accessory of

heating machine (K). Microscope shade plate on push-in position (L).
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Note: Depending on cell types, you need to check the optimal electroporation parameters.

*Neon Transfection System Cell Line Data and transfection parameters can be found on the manu-

facturer’s website.

https://www.thermofisher.com/jp/ja/home/life-science/cell-culture/transfection/neon-transfection-

system/neon-transfection-system-cell-line-data.html.

CRITICAL: To ensure reproducibility and eliminate variation of the transfection conditions

within or between experiments, use each Neon tip only at single time. Discard the used

Neon tip into an appropriate biological hazardous waste container.

Neon Transfection System manual can be found on the manufacturer’s website.

https://assets.thermofisher.com/TFS-Assets/LSG/manuals/neon_device_man.pdf.

Note: It is recommended that experiments be performed with cells in the same condition as

much as possible. In our experiments, we defrost the cells after each experiment and use them

as soon as their condition is restored, in order to avoid changes in cell properties due to dif-

ferences in the number of passages and contamination during culture. Cells that have under-

gone repeated passages are not used.

Note: Cells should be grown at 80%–90% confluence when you passage the cells.

Note: The pre-coating of Poly-L-Lysine is used to enhance cell adhesion after electroporation.

Note: The Neon pipette is used only with Neon tips. Do not use any other tips for the Neon

pipette.

Note: The medium used in electroporation process should not contain antibiotics in order to

keep cell viability after electroporation.

Note: Preliminary experiments are required to determine the optimal transfection ratio of two

plasmid vector, in this protocol, we used 1.5 mg/35 mm glass coverslip bottom dish AT1-EGFP

and 0.5 mg/35 mm glass coverslip bottom dish mScarlet-LOX-1 to perform transfection.

Note: In this study, we are performing gene expression by electroporation. Other gene deliv-

ery methods, such as viruses, can be used for both in vitro and in vivo experiments (Fus-Kujawa

et al., 2021).

Spinning-disk confocal live-cell imaging of receptors in the single cell

Timing: 10 min

In this part, we describe how tomake dynamic recordings of the above transfected cells under super-

resolution microscopy.

4. Wash the sample dish three times with pre-warmed 37�C 900 mL/35 mm glass coverslip bottom

dish imaging buffer and keep 900 mL/35 mm glass coverslip bottom dish to the sample dish

before microscopic observation is initiated.

5. To start operating the super-resolution microscope, ensure a secure connection between the

microscope and the PC software cellSens Dimension 1.11 (Olympus, Japan) (Figure 1J).
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6. Turn on the 488 nm (green) and 561 nm (red) laser channels at 20% power, and subsequently

adjust the laser power according to the image brightness. Set the film recording time to a total

of 5 min, 60 cycles, and 5 s interval. Turn on the auto focus.

7. Add a drop of lens oil to the 1003 NA 1.49 objective, then place the sample dish on it, fix the

dish with the matching clamp, and turn on the heater provided by the manufacturer (STX Series

Stage Top Incubator System, Tokai Hit, Japan) to keep the sample at ambient temperature at

37�C (Figure 1K).

8. Under the EYE1DIC (Differential Interference Contrast) mode, adjust the focus to obtain clear

images of the cells, then switch the channel to EYE2-G (green channel) or EYE3-R (red channel)

to check the fluorescence expression and seek the best target single cell.

9. After selecting the cell area, click ‘‘Start’’ to initiate image recording and add 100 mL of stimulus

(1/10 final concentration diluted by imaging buffer, imaging buffer and oxLDL are used as

vehicle and stimulus respectively in this protocol) or vehicle to the sample dish just after a

1-min image has been captured.

10. Green and red channels, and the backgrounds of the two channels are subtracted using the 3D

deconvolution algorithm of cellSens Dimension 1.11, and finally the two processed channels are

combined to form the merged image (Figure 2 and Methods video S1).

Note: If there is a problem with the connection between the microscope and the PC, a pop-up

appears. At that time, please follow the displayed pop-up.

Note: Choose and keep the laser settings and microscope configuration consistent between

conditions to get high quality quantitative data.

Note: It is very important to find an optimal visualization of the cell in both the green and red

channels. The best cell exhibits clear green and red puncta that are moving temporally. If you

cannot find the best cell from the software screen, you can look for them under themicroscope

eyepiece. Prior to turn on microscope eyepiece mode, make sure the microscope shade plate

needs to be on push-in position Figure 1L).

Note:Gently add the stimulus to the sample dish without any disturbance or movement of the

selected cell area. It might need to cease the imaging cycle for drug addition when focus is

altered.

Note: The focus may shift during stimulation. Please stimulate in a gentlemanly manner-slowly

push the pipette to release reagent to periphery of dish. In this experiment, we use a micro-

scope with autofocus function, which allows us to obtain stable live images. You can also use a

perfusion device as an alternative method.

Note: If bleach correction is required on the captured image, it should be performed prior to

analysis.

EXPECTED OUTCOMES

Green and red puncta images with a clear background can be obtained by the above procedure. In

addition, the movement and disappearance of the puncta after ligand stimulation can be analyzed

during the 5-min image loading process.

QUANTIFICATION AND STATISTICAL ANALYSIS

Timing: 1–2 days
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Puncta counting was performed before application (N1; 1 min after the imaging acquisition) and at

4 min point (N4; 3 min after the stimulation), using separated images to observe red puncta (mScar-

let-LOX-1) and green puncta (AT1R-EGFP). The cells were stimulated just after the 1 min point.

Although the number of puncta was counted manually by a blind observer in a previous publication

(Takahashi et al., 2021), we have currently updated the counting method using the ImageJ plugin to

count puncta automatically. The percentage change of puncta is calculated by the following formula:

(N1-N4)/N1 3 100%. The workflow of ImageJ is as follows:

1. Open red and green channel image files.

2. Image>Type>8-bit.

3. Image>Adjust>Threshold>click Dark background.

4. Polygon selections>define selected cell area in the green channel.

5. Analyze>Tool>ROI Manager>click add[t] to red channel.

6. Analyze> Analyze Particles>Size (20–200), Circularity (0.65–1.00)>click OK g. Obtain the

counted puncta of green channel.

7. Repeat the previous step to obtain the count puncta for the red channel.

8. Plugins>Colocalization>Ratio 50%, check colocalized points 8-bit>click OK.

9. Repeat step c and d to merged images.

10. Open the ROI Manager window> click measure.

11. Open results window>Edit>Select All>Copy and paste these results into excel. Determine the

number of puncta in themerge channel by counting the number of puncta in excel file with mean

value above 0.

12. Count results are collected for N1 and N4 images (Figure 3).

13. Analysis of internalization of AT1 and LOX-1 to stimuli.

Figure 2. Two receptors internalization triggered by the stimulation

Imaging of CHO-K1 cells co-transfected with mScarlet-LOX-1 and control or AT1-EGFP. Cells were preincubated for

1 min and stimulated. In the current protocol, we use 10 mg/mL oxLDL for stimulation. The imaging of before (0 min)

and 3 min after stimulation. The imaging was observed by a confocal super-resolution microscope.
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(Result of the comparison between cells treated with vehicle and oxLDL in Figure 4).

LIMITATIONS

As the automatic count of puncta depends on the size of particles, very small puncta would be

excluded from the analysis. The background particles with circularity and magnitude close to that

of the real puncta might be included in the analysis. In this study, the rate of change was calculated

by comparing images at two time points before and after stimulation and change over time was not

calculated for all images. The ImageJ plugin can only analyze 8-bit images. This approach only can

be applied to single cell but not to tissue or organ. This approach is also based on a cellular system of

receptor overexpression and therefore difficult to play in native cells to study the relationship of

endogenous receptors. In short, this approach does not meet the need to explore protein interac-

tions of interest beyond engineered cell systems.

Figure 3. Puncta counting and colocalization analysis

A count of puncta was performed using separated images visualizing mScarlet-LOX-1 and AT1-EGFP just before

(N1=1 min after the imaging acquisition) and 4 min point (N4; 3 min after the stimulation). The number of puncta at 1

and 4 min was determined by ImageJ. Change of the puncta was calculated as (N1-N4)/N1 3 100 (%).
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TROUBLESHOOTING

Problem 1

The electroporation device screen displays error message (related to step 2).

Potential solution

Make sure that the Neon pipette and cuvette are properly inserted into the Neon station separately.

The metal tip of the Neon pipette should be tightly attached to the spherical plunger inside the

pipette station. The side electrode of the Neon tube should be tightly attached to the spherical

plunger inside the pipette station.

Problem 2

There is a connection failure message on electroporation device screen (related to step 2).

Potential solution

Check that the correct voltage value is entered. Make sure that the Neon tip is properly inserted into

the Neon pipette and that there is no gap between the tip and the top cap of the pipette.

Problem 3

Cells have low viability after electroporation (related to step 2).

Potential solution

Avoid using excessively confluent cells or high-density cells. 80%–90% cell confluence is recom-

mending. Ensure that the cell culture medium after electroporation is free of antibiotics.

Problem 4

The mobile activity of the cell puncta is lower than expected (related to steps 2 and 3).

Potential solution

This problem shares common solution with Problem 5. For complete details of this solution please

refer to the Potential Solution of Problem 5. Regarding troubleshooting of SpinSR10 microscope

operation, please refer to following manual.

Problem 5

The intensity of the receptor fluorescence is lower than expected (related to steps 2 and 3).

Potential solution

This problemmay be caused by low transfection efficiency of electroporation, quality of plasmid DNA or

low ambient temperature during cell observation. First, check whether the optimal electroporation

Figure 4. AT1 and LOX-1 internalization in response to oxLDL stimulation

Change in mScarlet-LOX-1 and AT1-EGFP puncta in CHO-K1 cells stimulated with vehicle (n = 10) or 10 mg/mL Ox-LDL

(n= 11). Data are represented as mean G SEM. The difference between the application of vehicle and oxLDL was

determined by Student’s t-test. *p < 0.05, **p< 0.01.
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parameters are selectedbased on the cell type. Avoid creating any air bubbles in theNeon tip when aspi-

rating the sample mixture. This is followed by preliminary experiments to optimize the concentration of

DNA plasmids used in electroporation and to check the purity of the DNA plasmids. Finally, turn on the

heater during the observation process and store the subsequent samples in a 37�C incubator.

Problem 6

Non-specific fluorescent signal and no required puncta (related to steps 2 and 3).

Potential solution

This problem could be raised by cell auto-fluorescence. First choose cells with good fluorescence

expression of both green and red channels, which displays proper mobile activity of puncta and in-

tensity of fluorescence. Then increase the laser power to fit in empirically. Always passage cells with

compatible confluency levels.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact Toshimasa Takahashi (toshimasa.takahashi@geriat.med.osaka-u.ac.jp).

Materials availability

All plasmids generated in this study are available from the lead contact without restriction.

Data and code availability

The data sets supporting the current study are available from the lead contact up on reasonable

request.
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